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[bookmark: _Toc404759146]BACKGROUND
A.	The United States of America (“United States”), on behalf of the Administrator of the United States Environmental Protection Agency (EPA), filed a complaint in this matter pursuant to [insert causes of action and relief sought, e.g.: Sections 106 and 107(a) of the Comprehensive Environmental Response, Compensation, and Liability Act (CERCLA), as amended, seeking injunctive relief regarding the cleanup of the [insert site name] in [insert City, County, State] (“Site”), and recovery of costs incurred and to be incurred in responding to the release or threat of release of hazardous substances at or in connection with the Site”].
	B.	As a result of the release or threatened release of hazardous substances at the Site, EPA has undertaken response actions at or in connection with the Site under Section 104 of CERCLA, 42 U.S.C. § 9604 [, and will undertake response actions in the future]. In performing these response actions, EPA has incurred [and will continue to incur] response costs at or in connection with the Site. [OPTIONAL: Insert brief description of response actions undertaken at (or proposed for) the Site to date by EPA or other persons, noting whether a removal, remedial investigation/feasibility study, or record of decision has been completed. Describe briefly any previous settlements for performance of work or recovery of costs.]
	C.	EPA has determined the following:
		1.	Settling Defendant is an “owner,” as defined in Section 101(20), 42 U.S.C. § 9601(20), and within the meaning of Section 107(a)(1) of CERCLA, 42 U.S.C. § 9607(a)(1), of a “facility,” as defined in Section 101(9) of CERCLA, 42 U.S.C. § 9601(9), and is a “potentially responsible party” within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1);
		2.	Prompt settlement with Settling Defendant is practicable and in the public interest within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1);
[NOTE: Use Paragraph 3 where the consideration includes a cash payment. The dollar figure inserted should include the total response costs incurred to date as well as the Agency’s projection of the total response costs to be incurred during completion of response actions at the Site. The response cost total should include United States’ costs and costs incurred by other persons.]
		3.	The payment to be made by Settling Defendant under this Consent Decree involves only a minor portion of the response costs at the Site within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1), based upon EPA’s estimate that the total response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund and by other persons is [insert either “$______” or “between $______ and $______”]; and
		4.	Based upon information currently known to EPA, EPA has determined that Settling Defendant qualifies for a de minimis settlement pursuant to Section 122(g)(1)(B) of CERCLA, 42 U.S.C. § 9622(g)(1)(B).
	D.	Settling Defendant does not admit any liability to the United States arising out of the transactions or occurrences alleged in the complaint.
	E.	The United States and Settling Defendants agree, and this Court by entering this Consent Decree finds, that this Consent Decree has been negotiated by the Parties in good faith, that settlement of this matter without further litigation and without the [any further] admission or adjudication of any issue of fact or law is appropriate and will avoid prolonged and complicated litigation between the Parties, and that this Consent Decree is fair, reasonable, and in the public interest.
	THEREFORE, with the consent of the Parties to this Consent Decree, it is ORDERED, ADJUDGED, and DECREED:
[bookmark: _Toc404759147]JURISDICTION
This Court has jurisdiction over the subject matter of this action pursuant to 28 U.S.C. §§ 1331 and 1345 and 42 U.S.C. §§ 9606, 9607, and 9613(b), and also has personal jurisdiction over Settling Defendant. Settling Defendant consents to and shall not challenge the terms of this Consent Decree or this Court’s jurisdiction to enter and enforce this Consent Decree. 
[bookmark: _Toc404759148]PARTIES BOUND
This Consent Decree is binding upon the United States and upon Settling Defendant and Settling Defendant’s [heirs,] successors and assigns. Any change in ownership or corporate or other legal status of Settling Defendant, including but not limited to, any transfer of assets or real or personal property, shall in no way alter Settling Defendant’s responsibilities under this Consent Decree. 
[bookmark: _Toc404759149]DEFINITIONS
[bookmark: _Ref375645809]Unless otherwise expressly provided herein, terms used in this Consent Decree that are defined in CERCLA or in regulations promulgated under CERCLA shall have the meaning assigned to them in the statute or regulations. Whenever the terms listed below are used in this Consent Decree, the following definitions shall apply: 
[NOTE: In the following definition, it is generally sufficient to describe the property using the street address or the tax parcel ID number, but you also may use the legal property description. Legal property descriptions can be lengthy. It is common in conveyance documents to include the legal property description in an attachment. If using a legal property description, it should be the kind found in a deed.]
“Affected Property” means all real property at the Site and any other real property, owned or controlled by Settling Defendant, where EPA determines, at any time, that access or land, water, or other resource use restrictions are needed to implement response actions at the Site, including, but not limited to, the following properties [insert property descriptions].
“CERCLA” shall mean the Comprehensive Environmental Response, Compensation, and Liability Act, as amended, 42 U.S.C. §§ 9601-9675.
“Consent Decree” shall mean this Consent Decree and all appendices attached hereto. In the event of conflict between this Consent Decree and any appendix, the Consent Decree shall control.
“Day” or “day” shall mean a calendar day. In computing any period of time under this Consent Decree, where the last day would fall on a Saturday, Sunday, or federal or State holiday, the period shall run until the close of business of the next working day.
“DOJ” shall mean the United States Department of Justice and its successor departments, agencies, or instrumentalities.
“Effective Date” shall mean the date upon which the approval of this Consent Decree is recorded on the Court’s docket.
“EPA” shall mean the United States Environmental Protection Agency.
“EPA Hazardous Substance Superfund” shall mean the Hazardous Substance Superfund established by the Internal Revenue Code, 26 U.S.C. § 9507.
[NOTE: Insert the following definition if the consideration includes a cash payment.] 
“Interest” shall mean interest at the rate specified for interest on investments of the EPA Hazardous Substance Superfund established by 26 U.S.C. § 9507, compounded annually on October 1 of each year, in accordance with 42 U.S.C. § 9607(a). The applicable rate of interest shall be the rate in effect at the time the interest accrues. The rate of interest is subject to change on October 1 of each year. Rates are available online at https://www.epa.gov/superfund/superfund-interest-rates.
“National Contingency Plan” or “NCP” shall mean the National Oil and Hazardous Substances Pollution Contingency Plan promulgated pursuant to Section 105 of CERCLA, 42 U.S.C. § 9605, codified at 40 C.F.R. Part 300, and any amendments thereto.
“Paragraph” shall mean a portion of this Consent Decree identified by an Arabic numeral or an upper- or lower-case letter.
“Parties” shall mean the United States and Settling Defendant.
“Property” shall mean that portion of the “Site” that is owned by Defendant as of [insert date]. The Property is located at [insert address] in [insert City, County, State], and is designated by the following property description: ______.] [If Property and Site are the same, then define Site only, but include in the definition a description of the property.]
 “RCRA” shall mean the Solid Waste Disposal Act, as amended, 42 U.S.C. §§ 6901-6992 (also known as the Resource Conservation and Recovery Act).	
“Section” shall mean a portion of this Consent Decree identified by a Roman numeral.
“Settling Defendant” shall mean [insert name].
“Site” shall mean the ______ Superfund Site, encompassing approximately ____ acres, located at [insert address or description of location] in [insert City, County, State] and [insert either: “generally shown on the map attached as Appendix A” or “generally designated by the following property description: ______.”]
[NOTE: Insert the following definition only if the consideration includes a cash payment.]
“[Site name] Special Account” shall mean the special account, within the EPA Hazardous Substance Superfund, established for the Site by EPA pursuant to Section 122(b)(3) of CERCLA, 42 U.S.C. § 9622(b)(3), and [if applicable, identify prior settlement under which EPA established the special account].
“State” shall mean the State [or Commonwealth] of ______.
[NOTE: Insert the following definition if Section VII (Property Requirements) is included in the Consent Decree.] 
[“Transfer” shall mean to sell, assign, convey, lease, mortgage, or grant a security interest in, or where used as a noun, a sale, assignment, conveyance, or other disposition of any interest by operation of law or otherwise.] 
“United States” shall mean the United States of America and each department, agency, and instrumentality of the United States, including EPA.
[bookmark: _Toc404759150]STATEMENT OF PURPOSE
[NOTE: As drafted, this Statement of Purpose assumes that Settling Defendant is providing valuable consideration which may include any combination of access, cooperation, land, water, or other resource use restrictions, or cash in exchange for a full and final settlement with the United States for all civil liability under CERCLA §§ 106 and 107 with respect to the Site as a whole. When using this or any other Statement of Purpose, be sure that it is consistent with the Covenants by United States, the Reservations of Rights, and the definition of “matters addressed” in the Contribution provision. If institutional controls (ICs) or other response action is included in the consideration, this model should be adapted, as appropriate, as provisions relating to performance of the work, review and approval of plans, payment of future oversight costs, dispute resolution, etc. may be needed. Consult with the Office of Site Remediation Enforcement on drafting.] 
[bookmark: _Ref380157030]By entering into this Consent Decree, the mutual objectives of the Parties are:
to reach a final settlement between the Parties with respect to the Site pursuant to Section 122(g)(1)(B) of CERCLA, 42 U.S.C. § 9622(g)(1)(B), that allows Settling Defendant to provide valuable consideration to the United States to resolve Settling Defendant’s alleged civil liability under Sections 106 and 107 of CERCLA, 42 U.S.C. §§ 9606 and 9607, for injunctive relief with regard to the Site and for response costs incurred and to be incurred at or in connection with the Site, thereby reducing litigation relating to the Site;
to simplify any remaining administrative and judicial enforcement activities concerning the Site by eliminating a potentially responsible party from further involvement at the Site; [and]
[Use this Paragraph 4.c where the consideration includes a cash payment] to obtain settlement with Settling Defendant for Settling Defendant’s fair share of response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, and by other persons; and
to provide for full and complete contribution protection for Settling Defendant with regard to the Site pursuant to Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 9622(g)(5), or as may be otherwise provided by law, in accordance with Section XIII (Effect of Settlement/Contribution) herein.
[bookmark: _Ref320086932][bookmark: _Toc404759151]PAYMENT
[NOTE: Where settlement with a de minimis landowner does not require a cash payment, delete Section VI.]
[bookmark: _Ref320091195]Within 30 days after the Effective Date, Settling Defendant shall pay to EPA $______. 
Settling Defendant shall make payment by Fedwire Electronic Funds Transfer (EFT) in accordance with instructions provided to Settling Defendant by the Financial Litigation Unit (FLU) of the United States Attorney’s Office for the District of ______ after the Effective Date. The payment instructions provided by the FLU will include a Consolidated Debt Collection System (CDCS) number, Site Name, Site/Spill ID Number _______, and DJ Number _____, which shall be used to identify all payments required to be made in accordance with this Consent Decree. The FLU will provide the payment instructions to:
[Insert name, address, phone number, and email address of the individual who will be responsible for making the payment]

on behalf of Settling Defendant. Settling Defendant may change the individual to receive payment instructions on its behalf by providing written notice of such change to EPA and DOJ by email at:

EPA: 	[Project Coordinator email address]
		

DOJ:	eescdcopy.enrd@usdoj.gov 
	Re: DJ # ______
[bookmark: _Hlk65495436]Notice of Payment. At the time of payment, Settling Defendant shall send notice that such payment has been made to EPA and DOJ by email at:

EPA:	[Project Coordinator email address]

DOJ:	eescdcopy.enrd@usdoj.gov 
	Re: DJ # ______

Such notice shall reference the CDCS Number, Site Name, Site/Spill ID Number ______, and DJ Number ______.
[NOTE ABOUT SPECIAL ACCOUNTS: The Consent Decree should specify whether payment made under Paragraph 5 should be deposited in the EPA Hazardous Substance Superfund, or in a site-specific special account within the Hazardous Substance Superfund, or should be split between the Superfund and the Special Account (and should specify the split).]
[Insert one of the following three sentences here.] [The total amount to be paid pursuant to Paragraph 5 shall be deposited by EPA in the EPA Hazardous Substance Superfund.] [The total amount to be paid pursuant to Paragraph 5 shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] [Of the total amount to be paid pursuant to Paragraph 5 [“$___” or “___%”] shall be deposited by EPA in the EPA Hazardous Substance Superfund and [“$___” or “___%”] shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] 	
[bookmark: _Ref320087223][bookmark: _Ref396315253][bookmark: _Toc404759152]PROPERTY REQUIREMENTS
[NOTE: This Section should be used if access and/or use restrictions are needed. If access is needed to real property owned or controlled by Settling Defendant, use Paragraph 9.a. If land, water, or other resource use restrictions are needed on real property owned or controlled by Settling Defendant, use Paragraph 9.b. If EPA has issued a record of decision or an action memorandum that provides for ICs on real property owned by a Settling Defendant, then this model should be adapted, as appropriate, as provisions relating to ICs implementation, plan review and approval, payment of future response costs, dispute resolution, etc. may be needed. Consult with the Office of Site Remediation Enforcement on drafting. Additional changes to this section of the model will be needed in the event that access or land, water, or other resource use restrictions are needed on or affect a federal facility.]
[bookmark: _Ref387408967]Agreements Regarding Access and Non-Interference. Settling Defendant shall, with respect to its Affected Property:
[bookmark: _Ref386474494]Provide the United States [, the State,] potentially responsible parties who have entered or may enter into an agreement with the United States [or the State] for performance of response action at the Site (hereinafter “Performing Parties”), and their representatives, contractors, and subcontractors with access at all reasonable times to its Affected Property to conduct any activity relating to response actions at the Site including the following activities:
[NOTE: Augment this list as appropriate.]
Verifying any data or information submitted to the United States [or the State];
Conducting investigations regarding contamination at or near the Site;
Obtaining samples;
Assessing the need for, planning, implementing, or monitoring response actions;
Inspecting and copying records, operating logs, contracts, or other documents maintained or generated by Settling Defendant or its agents; 
Assessing Settling Defendant and any Performing Party’s compliance with the Consent Decree;
Determining whether the Affected Property is being used in a manner that is prohibited or restricted, or that may need to be prohibited or restricted, under the Consent Decree; and
Implementing, monitoring, maintaining, reporting on, and enforcing [any institutional controls or] any land, water, or other resource use restrictions regarding the Affected Property.
[bookmark: _Ref386474504]Refrain from using its Affected Property in any manner that EPA determines will (i) pose an unacceptable risk to human health or to the environment due to exposure to hazardous substances or (ii) interfere with or adversely affect the implementation, integrity, or protectiveness of response actions at the Site, including the following restrictions:
[NOTE: Customize and augment this list as appropriate. Be as specific as possible.]
Prohibiting the following activities which could interfere with response actions at the Site: ______;
Prohibiting use of contaminated groundwater; 
Prohibiting the following activities which could result in exposure to contaminants in subsurface soils and groundwater: ______; 
Ensuring that any new structures on the Affected Property will not be constructed in the following manner which could interfere with response actions at the Site: ______; and
Ensuring that any new structures on the Affected Property will be constructed in the following manner which will minimize potential risk of inhalation of contaminants: ______.
Settling Defendant shall not Transfer its Affected Property without first securing EPA’s approval of, and transferee’s consent to, an agreement that: (i) is enforceable by the United States [and the State]; and (ii) requires the transferee to provide access to and to refrain from using the Affected Property to the same extent as is provided under Paragraph 9 (Agreements Regarding Access and Non-Interference).
If EPA determines in a decision document prepared in accordance with the NCP that institutional controls in the form of state or local laws, regulations, ordinances, zoning restrictions, or other governmental controls or notices are needed regarding the Affected Property, Settling Defendant shall cooperate with EPA’s [and the State’s] efforts to secure and ensure compliance with such institutional controls.
[bookmark: _Ref386474480]Notice to Successors-in-Title
Settling Defendant shall, within 15 days after the Effective Date, submit for EPA approval a notice to be filed regarding the Affected Property in the appropriate land records. The notice must: (1) include a proper legal description of the Affected Property; (2) provide notice to all successors-in-title: (i) that the Affected Property is part of, or related to, the Site; (ii) that EPA [performed / has selected] a response action for the Site [if applicable: ; and (iii) that potentially responsible parties are required to implement the response action]; and (3) identify the document requiring implementation of the response action, including, if applicable, the name and civil action or docket number of the matter. Settling Defendant shall record the notice within 10 days after EPA’s approval of the notice and submit to EPA, within 10 days thereafter, a certified copy of the recorded notice.
Settling Defendant shall, prior to entering into a contract to Transfer its Affected Property, or 60 days prior to Transferring its Affected Property, whichever is earlier:
Notify the proposed transferee that EPA [performed / has selected] a response action regarding the Site [if applicable: , that potentially responsible parties are required to implement response actions regarding the Site, including information identifying the document requiring such implementation]; and
Notify EPA [and the State] of the name and address of the proposed transferee and provide EPA [and the State] with a copy of the above notice that it provided to the proposed transferee.
In the event of any Transfer of the Affected Property, unless the United States otherwise consents in writing, Settling Defendant shall continue to comply with its obligations under the Consent Decree.
[bookmark: _Ref339371275]Notwithstanding any provision of the Consent Decree, the United States [and the State] retain[s] all of its [their] access authorities and rights, as well as all of its [their] rights to require institutional controls, including enforcement authorities related thereto, under CERCLA, RCRA, and any other applicable statute or regulations.
[bookmark: _Ref320088024][bookmark: _Toc404759153]DUE CARE AND COOPERATION
Nothing in this Consent Decree shall be construed to relieve Settling Defendant of Settling Defendant’s duty to exercise due care with respect to hazardous substances at the Site or Settling Defendant’s duty to comply with all applicable laws and regulations.
[bookmark: _Ref320100642]Settling Defendant agrees to cooperate fully with EPA in the implementation of response actions at the Site and further agrees not to interfere with such response actions. EPA agrees, consistent with its responsibilities under applicable law, to use reasonable efforts to minimize interference with Settling Defendant’s operations by such entry and response. In the event that Settling Defendant becomes aware of any action or occurrence that causes or threatens a release of hazardous substances, pollutants, or contaminants at or from the Site that constitutes an emergency situation or may present an immediate threat to public health or welfare or the environment, Settling Defendant shall immediately take all appropriate action to prevent, abate, or minimize such release or threat of release, and shall, in addition to complying with any applicable notification requirements under Section 103 of CERCLA, 42 U.S.C. § 9603, or any other law, immediately notify EPA of such release or threatened release. 
[bookmark: _Toc404759154]FAILURE TO COMPLY WITH REQUIREMENTS OF CONSENT DECREE 
[bookmark: _Ref320091032][If consideration includes a cash payment, insert: If Settling Defendant fails to make full payment within the time required by Section VI (Payment), Settling Defendant shall pay Interest on the unpaid balance, which shall accrue from the Effective Date until the date of payment. In addition,] [insert in all settlements: [if/If] Settling Defendant fails to comply with the requirements of [insert all that apply: Section VII (Property Requirements), or VIII (Due Care and Cooperation), the United States may, in addition to any other available remedies or sanctions, bring an action against Settling Defendant seeking injunctive relief to compel compliance with this Consent Decree and/or seeking civil penalties under Section 122(l) of CERCLA, 42 U.S.C. § 9622(l), for the failure to comply. [NOTE: If Settling Defendant is performing remedial action under the Consent Decree, stipulated penalties pursuant to Section 121(e)(2) of CERCLA, 42 U.S.C. § 9621(e)(2), must be included.]
[bookmark: _Ref320088618][bookmark: _Toc404759155]COVENANTS BY UNITED STATES
[bookmark: _Ref320101350]Except as specifically provided in Section XI (Reservations of Rights by United States), the United States[footnoteRef:2] covenants not to sue or take administrative action against Settling Defendant pursuant to Sections 106 or 107 of CERCLA, 42 U.S.C. §§ 9606 or 9607, [and Section 7003 of RCRA, 42 U.S.C. § 6973,][footnoteRef:3] relating to the Site. With respect to present and future liability, these covenants shall take effect upon the Effective Date. These covenants are conditioned upon the satisfactory performance by Settling Defendant of all obligations under this Consent Decree and the veracity of the information provided to EPA by Settling Defendant relating to Settling Defendant’s involvement with the Site. These covenants extend only to Settling Defendant and do not extend to any other person. [2:  If any agency other than EPA or DOJ, such as Coast Guard or Federal Emergency Management Agency, has or may incur response costs at the Site, such costs must either be addressed in the settlement or reserved in Paragraph 19 (general reservations).]  [3:  If including a RCRA § 7003 covenant in Paragraph 18, pursuant to Section 7003(d) of RCRA, you must offer to have a public meeting regarding the settlement and hold such a meeting if requested. To do this, please include language in the Federal Register notice providing for an opportunity for a public meeting in the affected area. For guidance regarding how to comply with this requirement, see “Revised Model Notice Language for Compliance with Public Participation Requirements of Section 7003(d) of RCRA” (Oct. 30, 1996), available at https://www.epa.gov/enforcement/guidance-model-language-compliance-public-participation-requirements-under-rcra-section.] 

[bookmark: _Ref320088557][bookmark: _Toc404759156]RESERVATIONS OF RIGHTS BY UNITED STATES
[bookmark: _Ref320101473]The United States reserves, and this Consent Decree is without prejudice to, all rights against Settling Defendant with respect to all matters not expressly included within Section X (Covenants by United States). Notwithstanding any other provision of this Consent Decree, the United States reserves all rights against Settling Defendant with respect to:
[bookmark: _Ref320100610]liability for failure by Settling Defendant to meet a requirement of this Consent Decree;
liability as a result of failure to exercise due care with respect to hazardous substances at the Site;
liability resulting from exacerbation by Settling Defendant of the release or threat of release of hazardous substances from the Site;
[bookmark: _Ref320100624]criminal liability;
liability for damages for injury to, destruction of, or loss of natural resources, and for the costs of any natural resource damage assessments;[footnoteRef:4]  [4:  This natural resource damages reservation must be included unless the federal natural resource trustee(s) has/have agreed to a covenant not to sue pursuant to Section 122(j)(2) of CERCLA. In accordance with Section 122(j)(1) of CERCLA, where the release or threatened release of any hazardous substance at the Site may have resulted in damages to natural resources under the trusteeship of the United States, the Region should notify the federal natural resource trustee(s) of the negotiations and encourage the trustee(s) to participate in the negotiations.] 

[bookmark: _Ref320091063][include unless Settling Defendant owns the entire Site: liability based on the ownership of the Site by Settling Defendant when such ownership commences after signature of this Consent Decree by Settling Defendant;] 
[bookmark: _Ref320091073]liability based on the operation of the Site by Settling Defendant; and
[bookmark: _Ref320091079]liability based on Settling Defendant’s transportation, treatment, storage, or disposal, or arrangement for transportation, treatment, storage, or disposal of [a hazardous substance or a solid waste] [if Waste Material definition is used: Waste Material] at or in connection with the Site, after signature of this Consent Decree by Settling Defendant.
Nothing in this Consent Decree constitutes a covenant not to sue or to take action or otherwise limits the ability of the United States, including EPA, to seek or obtain further relief from Settling Defendant, and the Covenants by United States in Section X are null and void, if information not currently known to EPA is discovered that indicates that Settling Defendant fails to meet any of the criteria specified in Section 122(g)(1)(B).
[bookmark: _Ref320088682][bookmark: _Toc404759157]COVENANTS BY SETTLING DEFENDANT 
[bookmark: _Ref320101364]Settling Defendant covenants not to sue and agrees not to assert any claims or causes of action against the United States or its contractors or employees with respect to the Site[footnoteRef:5] or this Consent Decree including, but not limited to: [5:  The Covenants by United States in Paragraph 18 are drafted to resolve fully Settling Defendant’s liability for the Site as a whole. However, if this is not the case, the scope of Paragraph 21 (Covenants by Settling Defendant) may be narrowed to conform to the scope of the United States’ covenant not to sue.] 

any direct or indirect claim for reimbursement from the EPA Hazardous Substance Superfund based on Sections 106(b)(2), 107, 111, 112, or 113 of CERCLA, 42 U.S.C. §§ 9606(b)(2), 9607, 9611, 9612, or 9613, or any other provision of law;
any claim arising out of response actions at or in connection with the Site, including any claim under the United States Constitution, the Constitution of the State [Commonwealth] of ______, the Tucker Act, 28 U.S.C. § 1491, the Equal Access to Justice Act, 28 U.S.C. § 2412, or at common law; and 
[bookmark: _Ref320101545]any claim pursuant to Sections 107 and 113 of CERCLA, 42 U.S.C. §§ 9607 and 9613, Section 7002(a) of RCRA, 42 U.S.C. § 6972(a), or state law relating to the Site.[footnoteRef:6] [6:  Wherever possible, Settling Defendant should waive or otherwise give up claims against the United States in accordance with Paragraphs 21.c and 24 (waiver of claims). Where a claim is asserted by a potentially responsible party, or the Region has any information suggesting federal agency liability, all information relating to potential federal liability should be provided to the affected agency and DOJ as soon as possible in order to resolve any such issues, either in this settlement or a future settlement. Settlement of any federal liability will require additional revisions to this document. For information regarding CERCLA § 104(e) information requests to federal agencies, review the “Guidance on Issuing CERCLA Section 104(e)(2) Information Requests to Federal Agencies at Privately-owned Superfund Sites” (June 14, 2004), available at https://www.epa.gov/enforcement/guidance-issuing-superfund-104e2-information-requests-federal-agencies-privately-owned.] 

Except as provided in Paragraph 24 (waiver of claims) and Paragraph 29 (waiver of claim-splitting defenses), the covenants in this Section shall not apply in the event the United States brings a cause of action or issues an order pursuant to any of the reservations set forth in Section XI (Reservations of Rights by United States), other than in Paragraph 19.a (liability for failure to meet a requirement of Consent Decree) or 19.d (criminal liability), but only to the extent that Settling Defendant’s claims arise from the same response action, response costs, or damages that the United States is seeking pursuant to the applicable reservation.
Nothing in this Consent Decree shall be deemed to constitute approval or preauthorization of a claim within the meaning of Section 111 of CERCLA, 42 U.S.C. § 9611, or 40 C.F.R. § 300.700(d).
[bookmark: _Ref320091096][bookmark: _Ref387409580]Settling Defendant agrees not to assert any claims and to waive all claims or causes of action (including but not limited to claims or causes of action under Section 107(a) or 113 of CERCLA) that it may have for response costs [if natural resource damage claims are being resolved through this settlement, insert: and for natural resource damages and assessment costs] relating to the Site against [if multiple Settling Defendants insert: each other or] any other person who is a potentially responsible party under CERCLA at the Site. This waiver shall not apply with respect to any defense, claim, or cause of action that Settling Defendant may have against any person if such person asserts a claim or cause of action relating to the Site against Settling Defendant; nor shall it apply to any defense, claim, or cause of action arising out of action undertaken by Settling Defendant in response to a release or threat of release in accordance with Paragraph 16 (emergency response) of this Consent Decree. [NOTE: If Settling Defendant asserts that it has a claim against a potentially responsible party within the scope of this waiver that is unrelated to the PRP’s CERCLA liability at the Site, e.g., a claim for contractual indemnification, add an exception for such claim such as the following: This waiver also shall not apply to Settling Defendant’s contractual indemnification claim against [insert name].]
[bookmark: _Ref320087496][bookmark: _Toc404759158]EFFECT OF SETTLEMENT/CONTRIBUTION
[bookmark: _Ref387409452]Except as provided in Paragraph 24 (waiver of claims), nothing in this Consent Decree shall be construed to create any rights in, or grant any cause of action to, any person not a Party to this Consent Decree. Except as provided in Section XII (Covenants by Settling Defendant), the United States and Settling Defendant expressly reserve any and all rights (including, but not limited to, pursuant to Section 113 of CERCLA, 42 U.S.C. § 9613), defenses, claims, demands, and causes of action that they may have with respect to any matter, transaction, or occurrence relating in any way to the Site against any person not a Party hereto. Nothing in this Consent Decree diminishes the right of the United States, pursuant to Section 113(f)(2) and (3) of CERCLA, 42 U.S.C. § 9613(f)(2)-(3), to pursue any such persons to obtain additional response costs or response action and to enter into settlements that give rise to contribution protection pursuant to Section 113(f)(2). 
The Parties agree, and by entering this Consent Decree this Court finds, that this Consent Decree constitutes a judicially-approved settlement pursuant to which Settling Defendant has, as of the Effective Date, resolved liability to the United States within the meaning of Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 122(g)(5), and is entitled, as of the Effective Date, to protection from contribution actions or claims as provided by Sections 113(f)(2) and 122(g)(5) of CERCLA, or as may be otherwise provided by law, for the “matters addressed” in this Consent Decree. The “matters addressed” in this Consent Decree are [all response actions taken or to be taken and all response costs incurred or to be incurred, at or in connection with the Site, by the United States or any other person,[footnoteRef:7] except for the State];[footnoteRef:8] provided, however, that if the United States exercises rights under the reservations in Section XI (Reservations of Rights by United States), other than in Paragraph 19.a (liability for failure to meet a requirement of the Consent Decree) or 19.d (criminal liability), the “matters addressed” in this Consent Decree will no longer include those response costs or response actions [if the Decree includes a natural resource damages settlement include “or natural resource damages”] that are within the scope of the exercised reservation.  [7:  This definition of “matters addressed” assumes that this Consent Decree is designed to resolve fully Settling Defendant’s liability at the Site. If the intended resolution of liability is narrower in scope, then the definition of “matters addressed” will need to be narrowed.]  [8:  If the State is a party and is resolving its claims regarding the Site through this Consent Decree, delete “except for the State.” Note that state claims do not include claims for Hazardous Substance Superfund costs that have been provided to the State through a cooperative agreement with EPA and for which EPA retains the responsibility for cost recovery.] 

The Parties further agree, and by entering this Consent Decree this Court finds, that the complaint filed by the United States in this action is a civil action within the meaning of Section 113(f)(1) of CERCLA, 42 U.S.C. § 9613(f)(1), and that this Consent Decree constitutes a judicially-approved settlement pursuant to which Settling Defendant has, as of the Effective Date, resolved liability to the United States within the meaning of Section 113(f)(3)(B) of CERCLA, 42 U.S.C. § 9613(f)(3)(B).
Settling Defendant shall, with respect to any suit or claim brought by it for matters related to this Consent Decree, notify EPA and DOJ in writing no later than 60 days prior to the initiation of such suit or claim. Settling Defendant shall, with respect to any suit or claim brought against it for matters related to this Consent Decree, notify EPA and DOJ in writing within 10 days after service of the complaint or claim upon it. In addition, Settling Defendant shall notify EPA and DOJ within 10 days after service or receipt of any Motion for Summary Judgment and within 10 days after receipt of any order from a court setting a case for trial, for matters related to this Consent Decree.
[bookmark: _Ref380160516]In any subsequent administrative or judicial proceeding initiated by the United States for injunctive relief, recovery of response costs, or other relief relating to the Site, Settling Defendant shall not assert, and may not maintain, any defense or claim based upon the principles of waiver, res judicata, collateral estoppel, issue preclusion, claim-splitting, or other defenses based upon any contention that the claims raised in the subsequent proceeding were or should have been brought in the instant action; provided, however, that nothing in this Paragraph affects the enforceability of the Covenants by United States set forth in Section X.
[bookmark: _Toc404759159]CERTIFICATION OF SETTLING DEFENDANT
By signing this Consent Decree, Settling Defendant certifies [if multiple settlors: , individually,] that, to the best of its knowledge and belief, it: 
has conducted a thorough, comprehensive, good faith search for documents, and has fully and accurately disclosed to EPA, all information currently in its possession, or in the possession of its officers, directors, employees, contractors, or agents, that relates in any way to the ownership, operation, or control of the Site, or to the ownership, possession, generation, treatment, transportation, storage or disposal of a hazardous substance, pollutant, or contaminant at or in connection with the Site; 
has not altered, mutilated, discarded, destroyed, or otherwise disposed of any records, reports, documents, or other information (including records, reports, documents, or other information in electronic form) (other than identical copies) relating to its potential liability regarding the Site since notification of potential liability by the United States or the State; and 
has and will comply fully with any and all EPA and State requests for information regarding the Site pursuant to Sections 104(e), 122(e)(3)(B), and 122(g)(8) of CERCLA, 42 U.S.C. §§ 9604(e), 9622(e)(3)(B), and 9622(g)(8), Section 3007 of RCRA, 42 U.S.C. § 6927, and state law.
[bookmark: _Toc404759160]RETENTION OF JURISDICTION
This Court shall retain jurisdiction over this matter for the purpose of interpreting and enforcing the terms of this Consent Decree. 
[bookmark: _Toc404759161]INTEGRATION/APPENDICES
This Consent Decree and its appendices constitute the final, complete and exclusive agreement and understanding among the Parties with respect to the settlement embodied in this Consent Decree. The Parties acknowledge that there are no representations, agreements or understandings relating to the settlement other than those expressly contained in this Consent Decree. The following is attached and incorporated into this Consent Decree: “Appendix A” is [the map of the Site].
[bookmark: _Toc404759162][OPTIONAL: RELEASE OF LIEN]
[NOTE: This provision should not be used unless a Section 107(l) or 107(r) lien has been perfected. Since a qualifying de minimis landowner has to show that it purchased without knowledge of contamination, the purchase price of the property was most likely the fair market value without a reduction for contamination, and therefore the landowner would have realized no windfall due to EPA’s response work at the Site.] 
[Subject to the Reservation of Rights in Section XI, upon [payment of the amount specified in Section VI (Payment)], EPA agrees to release any lien it may have on the [Site] [Property] under Section 107 of CERCLA, 42 U.S.C. § 9607, with respect to Settling Defendant. [NOTE: If settling for access and due care only, modify language so that the release of the lien takes place following the Effective Date.]]
[bookmark: _Toc404759163]LODGING AND OPPORTUNITY FOR PUBLIC COMMENT
[bookmark: _Ref320091114]This Consent Decree shall be lodged with the Court for a period of at least 30 days for public notice and comment. The United States reserves the right to withdraw or withhold its consent if comments regarding the Consent Decree disclose facts or considerations that indicate that this Consent Decree is inappropriate, improper, or inadequate. Settling Defendant consents to entry of this Consent Decree without further notice.
If for any reason this Court should decline to approve this Consent Decree in the form presented, this agreement is voidable at the sole discretion of any Party and the terms of the agreement may not be used as evidence in any litigation between the Parties.
[bookmark: _Toc404759164]SIGNATORIES/SERVICE
Each undersigned representative of Settling Defendant to this Consent Decree and the Assistant Attorney General for the Environment and Natural Resources Division of the United States Department of Justice, or [his/her] designee, certifies that he or she is fully authorized to enter into the terms and conditions of this Consent Decree and to execute and bind legally such Party to this document.
Settling Defendant hereby agrees not to oppose entry of this Consent Decree by this Court or to challenge any provision of this Consent Decree, unless the United States has notified Settling Defendant in writing that it no longer supports entry of the Consent Decree.
Settling Defendant shall identify, on the attached signature page, the name and address of an agent who is authorized to accept service of process by mail on behalf of Settling Defendant with respect to all matters arising under or relating to this Consent Decree. Settling Defendant hereby agrees to accept service including, but not limited to, service of a summons, in that manner and to waive the formal service requirements set forth in Rule 4 of the Federal Rules of Civil Procedure and any applicable local rules of this Court.
[bookmark: _Ref320091125]The Parties agree that Settling Defendant need not file an answer to the complaint in this action unless or until the Court expressly declines to enter this Consent Decree. 
[bookmark: _Toc404759165]FINAL JUDGMENT
Upon entry of this Consent Decree by the Court, this Consent Decree shall constitute the final judgment between the United States and Settling Defendant. The Court [if this Consent Decree is a partial judgment, i.e., it resolves fewer than all the claims alleged in the complaint and/or the liability of fewer than all the parties named in the complaint, insert: finds that there is no just reason for delay and therefore] enters this judgment as a final judgment under Fed. R. Civ. P. 54 and 58. 
[bookmark: _Toc404759166]DISCLAIMER
This Consent Decree in no way constitutes a finding by EPA as to the risks to human health and the environment that may be posed by contamination at the Site nor constitutes any representation by EPA that the Site is fit for any particular purpose.

 SO ORDERED THIS     DAY OF         , 20___.


					________________________________________
					United States District Judge
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	[Name]
	Attorney
	Environmental Enforcement Section
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	United States Attorney
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	Assistant United States Attorney
	_______District of _______
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	[Name]
	Regional Administrator, Region __
	U.S. Environmental Protection Agency
	[Address]
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	[Name]
	Assistant Regional Counsel
	U.S. Environmental Protection Agency
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5
Instructions Regarding Automated Features

	Feature
	Instructions

	Inserting text copied from a different document
	Text copied from a different document will usually have embedded formatting codes. Pasting the text into your document will cause the formatting codes to be inserted as well, which will create unpredictable and frustrating formatting and numbering results. Therefore, ALWAYS use the “Paste Special” function to insert text copied from another document. Press Ctrl-Alt-V; in the pop-up menu, click “Unformatted Text” and OK. (You can also click the Home tab, Paste, Paste Special, Unformatted Text and OK.)

	Inserting a new paragraph
	Click at the end of the ¶ immediately preceding the place where you wish to add the new paragraph, and press Enter. To change the new ¶'s outline level use (under the Home tab) the styles menu. For example, to change ¶12.b into ¶12.a(1), click in that ¶ and then (using the Home tab) click the "LVL 3" style. To change ¶13.a into ¶14, click in that ¶ and then (using the Home tab) click the  “LVL 1” Style. Note that in consent decree models, the letters denoting each background paragraph must be manually updated.

	Adding an updateable section or paragraph cross-reference
	(a) Click where you wish to insert a cross-reference; (b) Click the “References” tab, and, in the “Captions” box, click “Cross-reference;” (c) In the pop-up menu that appears, make sure the “Reference type” field contains “Numbered item” and the “Insert reference to” field contains “Paragraph Number (full context); (d) In the “For which numbered item” field” select the numbered item (section, paragraph. or subparagraph) you wish to cross-reference, and click Insert.

	Updating the cross-references
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Update Field;” click OK. Note: If a numbered paragraph that has been cross-referenced elsewhere in the document is deleted, remove the obsolete paragraph cross-reference. Otherwise, when you update the cross-references, the following message will appear: “Error! Reference source not found.”

	Updating the table of contents
	Right-click in the TOC, and in the pop-up menu, left-click “Update Field.” Or click in the TOC, press F9, click Update Entire Table and OK. If you have just added a new section heading, click Update entire table before pressing Enter.

	Inserting a new section heading
	Click in the text of the new heading and assign the “SECTION” paragraph style to the text by clicking the “Home” tab, and in Styles box, clicking the “SECTION” style button.) That will add the section number, change the numbering of later sections, and ensure that the new section will be referenced in the table of contents.

	Changing the font
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Font;” in the “font” field, select a new font; click OK.




